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New Features

The following new features have been added in version 12.0 of TIBCO Spotfire® Analyst.

For details about new Spotfire features, see What's New in TIBCO Spotfire in the TIBCO Community.

Key Version Summary

SPOT-1657 12.0.0 External actions using TIBCO Cloud Integration

The new feature lets you take action in your business systems directly from the
visualizations. You can now trigger business processes, update databases, control
Internet of Things devices and much more, without having to leave your Spotfire
analysis.

This is made possible by integrating with TIBCO Cloud™ Integration, TCI. TCI offers
connectivity to a wide range of applications, databases and collaboration platforms,
 including custom applications reached by standard communication protocols.

With a hybrid cloud architecture, actions can be used in any Spotfire environment,
 both in the cloud and on premises. This also applies to the systems that actions can
integrate with.

Actions are created with no-code user interfaces, both when building the integration
apps in TIBCO Cloud Integration and when configuring them in Spotfire.

A security mechanism is provided to protect your sensitive data. Before an action can
be applied, it must be trusted, either by the person running the action, or indirectly by
the administrator specifying action configurators as trusted signers.

Note: External actions are not supported in the current versions of Spotfire mobile
apps (TIBCO Spotfire® for Apple iOS 2.13.0 and TIBCO Spotfire® for Android 1.4.5).

SPOT-1402 12.0.0 Page navigation at the top

The page navigation and status bar can now be displayed either above or below the
visualizations.

SPOT-1474 12.0.0 Access data from Amazon RDS for Oracle

You can now use the connector for Oracle to access data from Amazon RDS for Oracle.

SPOT-1503 12.0.0 Reduced startup time of Python data functions using pre-initialized background
processes

Whether you are running one or multiple Python data functions, you now have a
faster overall experience.

SPOT-1668 12.0.0 Display legend values horizontally

The values of the Color by, Shape by, and Series by legend items can now be displayed
in a horizontal legend.

The horizontal legend can be positioned on either the top or the bottom of the
visualization. The values inside the horizontal legend can have left, right, or center
alignment.

SPOT-1707 12.0.0 Access data from Amazon Redshift Serverless

You can now access data from Amazon Redshift Serverless with the connector for
Amazon Redshift.

SPOT-1730 12.0.0 Clickable links in data function descriptions

Clicking on a link in a data function description or a parameter description now opens
the target directly in a web browser.

TIBCO Spotfire® Analyst Release Notes
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Key Version Summary

SPOT-1766 12.0.0 Apply accessible color schemes to visualizations

You can now apply accessible color schemes for categorical columns with a palette
that is compliant with the WCAG 2.1 and conforms with Level AA or higher for the
contrast between text and background. There are two variants, one adapted for the
light theme and one for the dark theme.

SPOT-1772 12.0.0 Linear regression with intercept and slope in Data Relationships tool

A new option has been added in the Data Relationships tool to generate fit parameters
with intercept and slope information when using linear regression as comparison
method.

TS-68819 12.0.0 Preferred fonts specified by the administrator

An administrator can now specify a list of preferred fonts to help analysis authors
creating analyses based on fonts that are available to all users, for example, a company
font.

TS-69065 12.0.0 API to change the geometry simplification setting

The threshold for geometry simplification used in feature layers in map charts is now
exposed in the API. 

TS-69199 12.0.0 View version history in the Spotfire library

If version history is enabled on the Spotfire Server, then the File menu now includes
the option View version history. You can select this option if you have write access to
the currently-working analysis. For TIBCO Cloud™ Spotfire®, all versions are kept at
least 30 days. Non-named versions can be deleted after this period. For on-premises or
TIBCO Spotfire Cloud Enterprise solutions, the administrator determines the retention
policy.

See Reverting to a previous version of a file in the user's guide, or Library version
history in the TIBCO Spotfire® Server and Environment manual for more information.

TS-69354 12.0.0 Navigate to linked data table in data canvas

It is now possible to navigate from a linked copy of a data table to its source table in
the data canvas.

TSDC-6901 12.0.0 Spotfire application identifier in connections to Snowflake

When you access data with the connector for Snowflake, the queries from Spotfire to
Snowflake now include an identifier that states that the connection is from a Spotfire
application.

TSAS-1112 12.0.0 Configurable file system path in Automation Services tasks

Automation Services tasks can now use a new substitution field, exportPath. During
execution, the field is replaced by an actual path specified in the service configuration.
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Changes in Functionality

The following are important changes in functionality in version 12.0 of TIBCO Spotfire® Analyst.

Key Version Summary

TS-70536 12.0.2 Improved load balancing and error handling

When using multiple Spotfire servers with Web Player and Automation Services, the
Spotfire clients can now, in more cases and faster, detect that a server is not available or
strained.

TS-70585 12.0.2 Updated Python packages

The following included Python packages are updated in this release:

● numpy updated to 1.23.3

● pandas updated to 1.4.4

● setuptools updated to 65.3.0

TS-69963 12.0.1 Updated Log4Net

Log4Net updated to 2.0.15.

TS-69996 12.0.1 Updated TERR engine

Bundled TIBCO Enterprise Runtime for R engine updated to 6.0.1.

TSDC-7027 12.0.1 Removed fixed value for MaxBytesPerFetchRequest in connections to Apache Spark
SQL

When you access data with the connector for Apache Spark SQL, there is no longer a
fixed value for the connection property MaxBytesPerFetchRequest. The value is now
determined by the default value of the ODBC driver you use.

SPOT-1595 12.0.0 Dropped support for 32-bit operating systems

Spotfire Analyst, Spotfire Desktop, and Spotfire Developer no longer provide support
for 32-bit operating systems.

SPOT-1669 12.0.0 Increased maximum number of values per legend item

The default number of maximum values per legend item has been increased from 29 to
50. Existing analyses are not impacted by this change. The maximum number of values
can be further customized by an end user at a visualization level (from the Legend
page in the Visualization Properties), as a user level option (from Tools > Options), or
by an administrator as a group preference.

SPOT-1751 12.0.0 Updated Spotfire artwork

The Spotfire icon and artwork have been updated in Spotfire 12.

TIBCO Spotfire® Analyst Release Notes
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Key Version Summary

SPOT-1758 12.0.0 Updated operating system requirements

Microsoft Windows Server 2012 and Microsoft Windows Server 2012R2 are no longer
supported as the operating system for the following Spotfire products:

● TIBCO Spotfire Server

● TIBCO Spotfire Web Player

● TIBCO Spotfire Automation Services

● TIBCO Spotfire Statistics Services

● TIBCO Enterprise Runtime for R - Server Edition

● TIBCO Spotfire Service for Python

● Citrix with TIBCO Spotfire® Analyst & Desktop

● Remote Desktop Services with TIBCO Spotfire® Analyst & Desktop

TS-68514 12.0.0 Separate distribution files for Windows and Linux deployments

There are now two different distribution files available, one for Windows and one for
Linux. These files can be deployed to the same deployment area, or to separate areas.

For the language packs, each language now has two different distribution files: one
contains the complete set of language resources that cover both Windows and Linux,
 and one contains only the resources that are needed for a Web Player on Linux.

TS-69117 12.0.0 Python interpreter updated

The Python interpreter bundled with Spotfire is updated to version 3.10.4.

The following third-party Python packages are bundled with Spotfire. An asterisk ( * )
 indicates that the package version is updated in this release.

● bitstring 3.1.9

● numpy 1.22.4 *

● pandas 1.4.2 *

● pip 22.1.2 *

● python-dateutil 2.8.2

● pytz 2022.1 *

● setuptools 62.3.2 *

● six 1.16.0

● spotfire 1.8.0 *

● wheel 0.37.1

TSAS-1111 12.0.0 Fully qualified paths required in Automation Services tasks

The file system paths used in the following Automation Services tasks can no longer
use relative paths:

● Export Data to File

● Export Image

● Export Report to PDF

● Export to PDF

● Send Email

TIBCO Spotfire® Analyst Release Notes
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Key Version Summary

TSDC-6823 12.0.0 New name for Pivotal Greenplum connector

The data connector for Pivotal Greenplum has been renamed. It is now called the data
connector for Greenplum.

TSDC-6928 12.0.0 New name for Pivotal HAWQ connector

The data connector for Pivotal HAWQ has been renamed. It is now called the data
connector for Apache HAWQ.

TSDC-6944 12.0.0 Fixed value for MaxBytesPerFetchRequest in connections to Apache Spark SQL

When you access data with the connector for Apache Spark SQL, the value of the
connection property MaxBytesPerFetchRequest is now always 10MB, even if the
ODBC driver has a different default value.

TIBCO Spotfire® Analyst Release Notes
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Deprecated and Removed Features

Deprecated features

The table lists features that are deprecated and will be removed in a future release of TIBCO Spotfire®

Analyst.

Key Version Summary

SPOT-1521 12.0.0 The functionality Share to tibbr® is deprecated and no longer supported.

Deprecated since Spotfire 11.7.

TS-63679 12.0.0 The API to create requests to the server APIs , WebRequestFactory.
CreateSpotfireWebRequest(), has been deprecated in this release. All requests
to the server should be made using the standard APIs WebRequest.CreateHttp or
WebRequest.CreateDefault instead. Authentication and authorization to the server
APIs is done using OAuth2 and registered API client credentials. See the following
documentation for more information.

Spotfire Server SOAP APIs

Spotfire Server REST APIs

Web Services API Reference

Library REST API

Deprecated since Spotfire 10.10.0.

Removed features

No features have been removed in this release of TIBCO Spotfire® Analyst.
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Closed Issues

The table lists important closed issues in version 12.0 of TIBCO Spotfire® Analyst.

Key Version Summary

TS-70040 12.0.2 The order of data tables in the Filters panel is not copied when using 'Apply Filter
Organization'.

TS-70046 12.0.2 On-demand filter parameters that are not limited by any markings or filterings do not
get grouped together, which results in the wrong query being built.

TS-70048 12.0.2 Drop-down lists in text areas are not automatically updated when 'Include (None)
 alternative' is modified.

TS-70125 12.0.2 Any previously customized toolbar is reset, when the user lacks the license Customize
Toolbar.

TS-70430 12.0.2 Text areas that open authentication prompts cause Spotfire to close unexpectedly.

TSDC-7035 12.0.2 When you access data with the connector for Google BigQuery, long-running queries
for data sometimes stop because of a timeout. This happens because the OAuth access
token is not refreshed automatically.

TS-69835 12.0.1 Spotfire closes unexpectedly when a custom rule in a color scheme grouping is edited
in a table visualization.

TS-69880 12.0.1 The Spotfire client is closed unexpectedly when writing certain types of invalid search
expressions.

TS-69911 12.0.1 If you add a hierarchy in a cross table, and the new hierarchy has the same name as a
hierarchy that has previously been deleted, Spotfire closes unexpectedly.

TS-69915 12.0.1 When you configure a data connection, if you set up relations and joins in the data in
certain ways, Spotfire can stop unexpectedly when you try to use the connection.

TS-69958 12.0.1 When adding or configuring actions in Spotfire, it is possible to select services that use
integer as input data type, even though these services cannot be configured, nor called.

TSDC-7031 12.0.1 When you access data with the connector OData, an unnecessary request header is
included that sometimes causes the request for data to fail.

TSS-31495 12.0.1 In information links, Time/DateTime columns with milliseconds resolution can cause
issues with on-demand data tables.

TS-44684 12.0.0 It is not possible to specify display names for icon rules in graphical tables.

TS-58345 12.0.0 The documentation for Spotfire Administration Manager is not available as an online
web help.

TS-61839 12.0.0 Python data functions are sometimes slow to start up, and would benefit from having
pre-started Python processes (hot spares) available when running locally.

TIBCO Spotfire® Analyst Release Notes
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Key Version Summary

TS-63563 12.0.0 Clearing the check box ‘Visualization title visible by default’ in Tools > Options >
Visualization does not hide the visualization title.

TS-66112 12.0.0 If an analysis contains multiple data tables, the data table selected in the Data in
analysis flyout is sometimes not used when adding new visualizations on a new page.

TS-68274 12.0.0 Spotfire closes unexpectedly if you set the coordinate reference system to None in a
map chart that was originally created in another language.

TS-68456 12.0.0 Hierarchical date axes are displayed differently when visualizing sparse data in the
web client and the installed client. 

TS-68486 12.0.0 An unhelpful error message is shown when a user tries to open a visualization mod
created with a newer Mods API version than the API version supported by the
currently used Spotfire client version.

TS-68579 12.0.0 Numeric formatting in old analyses can sometimes show the wrong number of
decimals.

TS-68707 12.0.0 Editing in input fields or text areas might trigger other actions in Spotfire, such as
deleting marked data if the Delete key is pressed.

TS-68708 12.0.0 A mod signed with a certificate, where there is no method to check the revocation
status of the certificate because revocation is not supported by the certificate authority,
 is considered to have an invalid signature.

TS-68711 12.0.0 When reading data from certain streams (for example, via TIBCO Spotfire Statistics
Services, including when Statistics Services is called through Automation Services), an
internal issue causes data to be only partially read, and the data is therefore corrupted.

TS-68743 12.0.0 When an axis in a scatter plot is auto-binned, an error message is shown if you try to
open the axis popover for the binned axis.

TS-68748 12.0.0 Some multithreaded Python data functions never finish when run locally.

TS-68759 12.0.0 Clicking in a custom visualization does not change the active visualization or close
open pop-up menus.

TS-68806 12.0.0 When opening an analysis, and there are both automatically executing data functions
and on-demand data tables that depend on the output of the data functions, then the
on-demand action sometimes initially fails to fetch new data.

TS-68807 12.0.0 Log files currently opened for writing by another process cannot be added as a data
source.

TS-68834 12.0.0 It is no longer possible to launch the Edit Parameters user interface for data functions
by prompting on a DataFunction through the API.

TS-68851 12.0.0 When you save an analysis file that uses a data connection or connection data source
stored in the Spotfire library, saved credentials are also stored in the .dxp analysis file.

TS-68876 12.0.0 When you search for items in the Files and data flyout, it is not possible to view details
of a Recommended analysis.

TIBCO Spotfire® Analyst Release Notes
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Key Version Summary

TS-68891 12.0.0 Dragging an analysis to the visualizations canvas, while the Save as library flyout is
open, makes the application non-responsive.

TS-68907 12.0.0 Running Spotfire Analyst on Windows 11 with a connection to the Spotfire Server
through HTTPS and TLS 1.3 can cause stability issues.

TS-68926 12.0.0 It is not possible to specify display names for icon rules in text areas.

TS-68935 12.0.0 Load balancers (especially an AWS load balancer) between the Spotfire Analyst and
the Spotfire Server or between node services and the Spotfire Server can cause random
connection problems.

TS-68938 12.0.0 In map charts, labels are sometimes displayed incorrectly because scaling is not taken
into account.

TS-69073 12.0.0 The file path to the performance logger log file is missing a path separator, which
causes the log file to end up outside the ‘Logs’ folder.

TS-69104 12.0.0 'Set Up Data Source' is spelled incorrectly ('Setup Data Source') in the Information
Designer user interface.

TS-69184 12.0.0 When an administrator switches the user group for a user, the correct preferences are
sometimes not applied for the user until Spotfire Analyst has been restarted twice.

TS-69223 12.0.0 The TIBCO Spotfire Application Profiler Tech Note document contains an incorrect
command-line example.

TS-69238 12.0.0 The TIBCO Spotfire Application Profiler Tech Note document does not inform you that
the task scheduler setting Run whether the user is logged on or not is currently not
supported.

TS-69298 12.0.0 The documentation of the function Milliseconds erroneously states that the function
returns a Real value when using a TimeSpan argument, while it actually returns an
Integer value.

TS-69311 12.0.0 In some cases, reference lines based on Line from Data Table do not show up in the
correct trellis panel when multiple scales are used.

TS-69340 12.0.0 Reference lines computed on a non-aggregating axis in an aggregating visualization
are sometimes incorrect when combined with multiple scales.

TS-69501 12.0.0 The bundled Python interpreter does not include the include directory from the
Python distribution, which is required for installing some Python packages.

TS-69523 12.0.0 If a loading information link is interrupted by network errors, and at the same time the
database is changed, then the loading data could be corrupted. Now, in such a case, an
error occurs so that the user can retry loading. 

TS-69544 12.0.0 Custom JavaScript code, including visualization mods, does not work due to lack of
WebGL support.

TS-69790 12.0.0 The example for enabling external actions with TIBCO Cloud Integration is missing a
comma.

TIBCO Spotfire® Analyst Release Notes



12

Key Version Summary

TSDC-4954 12.0.0 When you access data with the connectors for Apache Drill or Dremio, some date and
time functions are not available for in-database data tables.

TSDC-6940 12.0.0 In the Microsoft SharePoint Online Connection dialog, it is not possible to add a
SharePoint Site if the URL contains spaces or encoded spaces (%20).

TSDC-6961 12.0.0 When you access data from Salesforce, an error occurs if a query from Spotfire to
Salesforce contains more than 16,000 characters.

TSDC-6972 12.0.0 When you access data with the connector for Amazon Redshift, sometimes valid
connection settings are incorrectly removed because of a case sensitive check.

TSDC-6984 12.0.0 An error occurs when you create or open data connections to TIBCO Cloud™ Live
Apps.

TSDC-6993 12.0.0 Expressions containing an aggregating function within a column function (where the
latter accepts more than one argument) cannot not be used as a calculated column or
as a visualization axis expression.

This affects the connectors for SAP HANA (when using Analytical Views). Attivio,
 IBM Netezza and Google BigQuery.

TIBCO Spotfire® Analyst Release Notes
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Known Issues

The following are known issues in version 12.0 of TIBCO Spotfire® Analyst.

Key Version Summary

TS-69770 12.0.1 Export error displayed for empty column

If you export an SBDF from Python (for example, as outputs for a data function), and
your output contains an empty column, then you can encounter the following error:

spotfire.sbdf.SBDFError: cannot determine type for column 'EmptyString'

; all values are missing

This error occurs because the spotfire package cannot always correctly infer data types,
 such as String.

Workaround: None.

TS-70072 12.0.1 In your Python data functions, if you export data containing a column with the data
type Integer (32-bit) and manipulate the data so that the column grows to 2 billion
or more, and then you attempt to reimport the data without changing the column
data type, then you generate an SBDFError exception. Note: The Integer data type
can be attached to input columns, depending on Pandas operations, and these can be
propagated to outputs.

Workaround: Use the function set_spotfire_types to set the data type to
LongInteger, and then reimport the data.

TS-62137 12.0.0 Python packages that are installed by the Administrator (through an SPK) take
precedence over packages installed using the Python Tools from the Spotfire Analyst
Tools menu. If users attempt to update a package previously installed by an SPK, then
the package update is installed, but the update is ignored.

TS-67478 12.0.0 Data connections created in Spotfire versions 11.5.0 and later using the TIBCO Spotfire
Connector for Amazon Redshift cannot be opened in versions earlier than 11.5.0.

Workaround: Refresh the schema and perform a table repair for the Data Connection
view.

TIBCO Spotfire® Analyst Release Notes
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Key Version Summary

TS-67656 12.0.0 "Unable to write data" error message

Error message "Unable to write data to the transport connection: An
established connection was aborted by the software in your host

machine."

If you see this error, then the data being uploaded to the service is too large. When
a Spotfire data function is run, it sends the relevant data from Spotfire to the service
for processing. The service has a file size upload limit, the default of which is 100 MB.
 When a data function is run with data that exceeds this limit, the service returns the
error.

An administrator can change this upload limit if needed by creating a custom
configuration. For more information, see the topic "File size upload limit" in the service
Installation and Administration guide.

If users see this error message, the administrator can consider creating a custom
configuration that increases the limits for both of the following properties:

● spring.servlet.multipart.max-file-size: The total file size for upload
cannot exceed the value for this setting.

● spring.servlet.multipart.max-request-size: The total request size for a
multipart file upload cannot exceed the value for this setting.

 

Note:  At a certain point, the Java Heap size fails to handle very large files. The
threshold for this behavior is dependent on the amount of RAM the service node has.
 When the Java Heap Size is exceeded, the following error message is displayed.

Error from Remote Service: Internal Server Error (500) - java.lang.

OutOfMemoryError: Java heap space

TIBCO Spotfire® Analyst Release Notes
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Installation

The following are instructions on how to install version 12.0 of TIBCO Spotfire® Analyst.

The TIBCO Spotfire® Analyst client is delivered as two different installers. The installer labelled
"single_user" is the default one. Use this if you do not know which version to select. The installer
labelled "single_user" installs the product for the logged in user only. The other users on the same
machine will not be able to use the client. The installer labelled "shared_computer" installs the product
for all users on the machine. This installer requires administrative privileges on the machine.

Installation of Release 12.0

1. First install/upgrade the TIBCO Spotfire® Server to version 12.0.

2. Deploy the TIBCO Spotfire® 12.0 distribution on the TIBCO Spotfire® Server 12.0.

3. Finally, install TIBCO Spotfire® Analyst 12.0 on all client computers.

Installation Notes

● If the .NET 4.8 framework is not installed, it will be downloaded and installed when launching the
"shared_computer" TIBCO Spotfire® Analyst client installer. The "single_user" installer will not
download the .NET framework, because it does not have system changing privileges. However, it
will complain if the .NET framework is missing.

● If the product localization is defined as a user group preference, a client restart is required after
the initial login to the server for the changes to be fully applied. Note that clients are not informed
that such a restart is required. It is also important that the appropriate localization packages are
deployed to the TIBCO Spotfire® Server prior to setting the user group preference.

Note that the correct language pack and the matching server preference must be set on the very first
server that the user connects to. Changing the settings on the Server will not have any effect. If the
localization group preference does not have any effect, it can be enforced on clients using Tools >
Options.

TIBCO Spotfire® Analyst Release Notes
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Migration and Compatibility

The following are instructions on how to migrate from a previous release to version 12.0 of TIBCO
Spotfire® Analyst.

Upgrading from Previous Version without Installing

1. First install/upgrade the TIBCO Spotfire® Server to version 12.0.

2. Deploy the TIBCO Spotfire® 12.0 distribution on the TIBCO Spotfire® Server 12.0.

3. Start the old version of TIBCO Spotfire® Analyst, log on to the TIBCO Spotfire® Server 12.0 and
accept the update.

With Spotfire 10.3, a trust mechanism for data functions was introduced. Also, the trust stamp
was changed to be calculated with SHA-512. Therefore, when updating from an older version to
10.3 or later, the trust stamps in all Spotfire analysis files in the library that include IronPython
scripts, JavaScripts, data connection custom queries or data functions must be updated. New
server CLI commands called "find-analysis-scripts" and "trust" can be used to find and update
or automatically trust old scripts and data functions in your library. For more information, see
the TIBCO Community article: https://community.tibco.com/wiki/script-and-data-function-trust-
spotfire-103-and-later.

Compatibility Versions

You can use TIBCO Spotfire 12.0 to open .dxp analysis files that were created and saved in any older
version of Spotfire that is still in support.

The compatibility versions of TIBCO Spotfire 12.0 are updated to versions 11.8 and 11.4 LTS. This
means that .dxp analysis files that you create and save in Spotfire 12.0 can be opened in versions 11.8
and 11.4 LTS of Spotfire.

When you use an older version of Spotfire to open an analysis file that was created in a newer
version of Spotfire, features from the newer version might not be available, and the analysis
might look and behave differently compared to the version in which it was created.

Version Compatibility versions

12.0 LTS 11.8, 11.4 LTS

11.8 11.7, 11.4 LTS

11.7 11.6, 11.4 LTS

11.6 11.5, 11.4 LTS

11.5 11.4 LTS, 10.10 LTS

11.4 LTS 11.3, 10.10 LTS

11.3 11.2, 10.10 LTS

11.2 11.1, 10.10 LTS

11.1 11.0, 10.10 LTS

TIBCO Spotfire® Analyst Release Notes
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11.0 10.10 LTS, 10.3 LTS

10.10 LTS 10.9, 10.3 LTS

10.3 LTS 10.2, 7.11 LTS

File compatibility example

For example, when you create a .dxp analysis file in Spotfire 11.7, the file is saved with
compatibility versions for 11.6 and 11.4 LTS. You can open the .dxp file in any older Spotfire
version that either is one of those versions, or has 11.6 or 11.4 LTS as compatibility versions.

That means you can open the .dxp analysis file that you saved in Spotfire 11.7 in the following
older versions: 11.6, 11.5, and 11.4 LTS.

Newer and older versions of Spotfire Analyst client can be used to connect to the current version of
Spotfire Server in order to upgrade or downgrade the client packages. However, it is recommended
to always run the same version of client and server in production environments. See System
Requirements.
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TIBCO Documentation and Support Services

For information about the Spotfire products, you can read the documentation, contact TIBCO Support,
and join the TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly
in HTML and PDF formats.

The website is updated frequently and is more current than any other documentation included with the
product.

TIBCO Spotfire Documentation

The documentation for all Spotfire products is available on the TIBCO Spotfire® Documentation page.
This page takes you directly to the latest version of each document.

To see documents for a specific Spotfire product or version, click the link of the product under 'Other
versions', and on the product page, choose your version from the top right selector.

Release Version Support

Some release versions of TIBCO Spotfire products are designated as long-term support (LTS) versions.
LTS versions are typically supported for up to 36 months from release. Defect corrections will typically
be delivered in a new release version and as hotfixes or service packs to one or more LTS versions. See
also https://docs.tibco.com/pub/spotfire/general/LTS/spotfire_LTS_releases.htm.

How to Contact TIBCO Support

Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

● For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the TIBCO Support portal at https://support.tibco.com.

● For creating a Support case, you must have a valid maintenance or support contract with TIBCO.
You also need a user name and password to log in to https://support.tibco.com. If you do not have a
user name, you can request one by clicking Register on the website.

System Requirements for Spotfire Products

For information about the system requirements for Spotfire products, visit http://spotfi.re/sr.

How to join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to
https://community.tibco.com.

For quick access to TIBCO Spotfire content, see https://community.tibco.com/products/spotfire.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY
(OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND
CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE
CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD
OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE
FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END
USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE "LICENSE" FILE(S) OF THE
SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE
BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this document
may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, TIBCO Spotfire, TIBCO Spotfire Analyst, TIBCO Spotfire
Automation Services, TIBCO Spotfire Server, TIBCO Spotfire Web Player, TIBCO Enterprise Runtime
for R, TIBCO Enterprise Runtime for R - Server Edition, TERR, TERR Server Edition, and TIBCO
Spotfire Statistics Services are either registered trademarks or trademarks of TIBCO Software Inc. in the
United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the readme.txt file for the
availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO
SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/
OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY
OR INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 1994-2022. TIBCO Software Inc. All Rights Reserved.
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